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1. Summary List of Enhancements in v4.80

This document describes enhancements in the Carrier Hourly Analysis Program (HAP) v4.80, released in
October, 2013. It is intended for new users and those upgrading from HAP v4.70. A summary list of
enhancements is provided below. Sections 2 through 6 describe the changes in greater detail.

1. Air Systems

 Added two new air system types: Induction Beams (IB) and Active Chilled Beams (ACB). This
includes default settings and values for all inputs.

 Added design calculations for IB and ACB systems, as well as associated reports.
 Added energy simulation calculations for IB and ACB systems.
 Added export of Induction Beam sizing data to Carrier Electronic Catalog for equipment selection.

See section 2 for further details

2. Plants

 Added ability to model waterside economizer with air-cooled chiller plants.

See section 3 for further details

3. Equipment Wizard

 Added two new air system types: Induction Beams (IB) and Active Chilled Beams (ACB). This
includes default settings and values for all inputs, and intelligent defaulting when transitioning
from the Wizard screens to the full HAP project. Also added new graphics for IB and ACB
terminals in the air system diagram.

See section 4 for further details

4. Other Features

 Updated Help Menu items to improve connectivity with Carrier help desk.
 Improved compatibility with computer configurations using dual monitors.
 Improved compatibility with computers having touch-screen capabilities.

See section 5 for further details

5. Bug Fixes

 Corrected problems reported in HAP v4.70

See section 6 for further details
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2. New Air System Features

1. Induction Beam Air Systems

A new type of air system has been added for modeling induction beams (IB). Induction beam systems
consist of a central ventilation unit (DOAS) and one or more induction beam terminals. The terminals
provide hydronic cooling for sensible and latent loads, and optional hydronic heating.

A number of features were added to control ventilation system behavior in unoccupied periods:
ventilation air damper position, reset of DOAS supply temperature setpoints, reduction in ventilation
fan airflow, and control options for the ventilation fan. These features allow system designers to tune
the overall performance and energy usage.

The induction beam terminal units can be individually configured. Performance is specified by setting
the values of airflow ratio and coil bypass factor.

2. Active Chilled Beam Air Systems

A new type of air system has been added for modeling active chilled beams (ACB). These systems
consist of a central ventilation unit (DOAS) and one or more active chilled beam terminals. The
terminals provide hydronic cooling for sensible loads only, and optional hydronic heating.

Active chilled beams share some of the capabilities of induction beams, although because they
cannot handle latent cooling loads at the air terminal (due to condensation on coil surfaces), the
available options are fewer. Dehumidification settings are also of primary importance. Features
available to ACB systems include unoccupied ventilation air damper position and reset of DOAS
supply temperature in unoccupied periods.

Individual ACB terminals are configured similar to induction beam terminals.

3. Design and Energy Simulation Calculations and Reports

The new induction beam and active chilled beam air systems have been integrated into HAP's design
sizing and energy simulation calculations, as well as the suite of reports available to display the
results of the calculations. While most of this integration is invisible to the user, some modifications
have been made to adjust the reports for these system types.

For design calculations, system design reports have been customized for Induction Beam and Active
Chilled Beam applications.

For energy simulations, annual, monthly, and hourly results were integrated into existing reports and
reporting categories.

4. Export to Carrier Electronic Catalog

Equipment sizing results can be exported to Carrier Electronic Catalog (E-CAT) for use in selection of
induction beam terminal equipment. This is done using the "Publish Equipment Sizing Requirements"
button on the toolbar or the corresponding option on the Project Menu. This "Publish" feature also
allows sizing requires for many other types of equipment to be exported to E-CAT.



Page 4 of 6

3. New Plant Features

1. Waterside Economizer for Air-Cooled Chiller Plants

Added the ability to model water-side economizer free cooling in chiller plants using air-cooled
chillers. In such a plant a cooling tower or dry cooler turns on and operates when it can deliver cold
enough water to provide 100% free cooling (non-integrated waterside economizer) or when it can
deliver cold enough water to precool return water and provide partial or 100% free cooling (integrated
waterside economizer). Previously this feature was limited to chiller plants containing water-cooled
chillers.

To use this feature:

a. Create a chiller plant.

b. On the Configuration tab check the box for free cooling and specify the type of free cooling.

c. Also on the Configuration tab, specify that "one tower is shared by all water-cooled chillers". In a
plant containing only air-cooled chillers, this will mean one tower or dry cooler is shared among
the air-cooled chillers for purposes of free cooling.

d. On the Schedule of Equipment tab select the cooling tower, dry cooler or geo/well source that will
serve as the heat rejection system providing the free cooling.

During the plant simulation, the software will evaluate hour by hour conditions. When conditions are
favorable for free cooling the heat rejection system will turn on to provide partial or 100% free cooling,
depending on the type of free cooling specified and the current conditions.

2. Distribution Loop Delta-T

The maximum delta-T which can be specified for a distribution loop for hot water applications has
been increased to 100 F (55.5 K). This exceeds the 50°F minimum requirement needed to comply
with LEED 2009. This is also consistent with hot water boilers, which already allowed a maximum
delta T of 100°F when specifying their flow rate in relative terms.

4. New Equipment Wizard Features

1. Induction Beam and Active Chilled Beam Air Systems

Added features for modeling Induction Beams (IB) and Active Chilled Beams (ACB) in the Equipment
Wizard. When one of these system types is selected, the wizard screens will display only the set of
inputs which are relevant.

To depict the configuration of these new system types, new graphics for IB and ACB terminals have
been created for the air system diagram. These simple diagrams depict the basic functionality of the
terminal units, including the induced airflow and zone recirculation as well as chilled and hot water
coils. They are visually distinct from other terminal unit types in order to reinforce these concepts and
ensure clarity.
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5. Other New Features

1. Help Menu Options

From the Help menu, the “Contact Customer Support” window now contains a clickable email
address which will automatically launch the user’s email program and pre-populate an email with the
e-mail address for Carrier Software Systems as well as basic details of the version of HAP being
used.. This information assists customer support personnel in diagnosing certain types of software
issues. Using this functionality to initiate contact with Carrier is recommended.

From the Help menu, the “About” window now will display basic software and system information.
This will facilitate support when calling the Carrier help desk.

2. Compatibility with Dual Monitor Computer Configurations

In certain situations the left-hand tree panel in HAP's main window became unresponsive. The
program did not respond to clicking items in the left-hand panel. This error only occurred on
computers using two monitors in which specific configuration settings were used, and HAP was
running on the secondary monitor rather than the primary monitor. HAP has been upgraded so it
should now run on all dual-monitor configurations. This issue was present in both v4.70 and earlier
versions.

3. Compatibility with Touch Screen Computers

When starting the program on a computer having touch screen capabilities the program would halt
and display Windows operating system message "Hourly Analysis Program has encountered a
problem and needs to close". HAP has been upgraded so it is now compatible with desktop, laptop
and tablet computers having touch screen capabilities, as long as that computer is running a
Windows operating system.

6. Bug Fixes

This section describes problems identified in HAP v4.70 which were corrected in HAP v4.80.

1. Plant Design Calculations I – In certain situations, when running plant design calculations for a
Service Hot Water (SHW) plant or a Hot Water Plant or Steam Plant which served both space and
SHW loads, the calculation halted and displayed an error message "Error 6 Overflow for SHW Plant
Design Calculations". This problem only occurred if the SHW maximum consumption rate was
defined in terms of gal/person/day (L/s/person/day) and the occupant population was larger than
1450.

2. Plant Design Calculations II – When plant design calculations were run for one of the "Generic"
plant types, any required air system design calculations were not automatically run first. This resulted
in plant peak load being incorrect. Note that if design calculations for the air systems served by the
plant had previously been run after the latest changes to the system, no error occurred. The error
only occurred if air system design calculations had not previously been run at all, or if changes to the
air systems had made since the design calculations were last run..

3. Plant Design Calculations III – In certain situations, when running plant design calculations for a
Service Hot Water (SHW) plant or a Hot Water Plant or Steam Plant which served both space and
SHW loads, the calculation would halt and display an error message "Unable to load schedule data."
This problem only occurred if air systems served by the plant have one or more spaces containing
zero occupants.

4. Editing Plants I – In certain situations, when opening the Plant Properties window to edit data, the
program halted and displayed the following error "Error 91 Object Variable or With Block Variable Not
Set". This problem only occurred if one of the air systems linked to the plant had been changed to
use a different source of cooling or heating. For example, this could involve a system originally
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defined as a chilled water AHU which was linked to a cooling plant, and then later the system was
changed into a packaged rooftop and therefore no longer contains chilled water coils.

5. Editing Plants II - For an unusual sequence of steps, the shared ground source for a hot water plant
using water-to-water heat pumps was not displayed on the plant properties window or the plant input
report. The required sequence involved starting with a project created in HAP v4.6 or a prior version
that contained a hot water boiler plant, converting the data to HAP v4.7 format, editing the boiler plant
and changing it to use water-to-water heat pumps and a shared geo source. This data is correctly
saved and used in calculations. But if you later edit the plant or generate the plant input report, the
shared geo source will not be displayed.

6. Editing Plants III - When running HAP with energy analysis features turned off and hidden, the
program did not offer options in the plant inputs for choosing plant types "Generic SHW Plant" and
"Generic Changeover Plant".

7. Editing Plants IV - When running in SI Metric units and defining a hot water plant or chilled water
plant with a primary/secondary distribution system, the secondary pump design flow rate is incorrectly
displayed on the Distribution tab. This value is automatically calculated from the equipment specified
on the Schedule of Equipment tab. The calculated value is correct and will be correctly used in
calculations. The error is only in the screen display of the data. If you generate a plant input report
you will see the flow correctly displayed there.

8. Editing Plants V - When running in SI Metric units and defining a remote chilled water or remote hot
water plant the secondary pump flow rate defined on the Distribution tab is incorrectly saved. This
will cause simulated pump input energy to be incorrect.

9. Air Systems – When a cooling-only air system was defined with dehumidification control and the
dehumidification reheat source was defined as hot water or steam, HAP failed to properly record the
reheat source. This prevented linking the air system to a hot water plant or steam plant. As a result,
energy costs for dehumidification reheat could not be calculated in this case. This error was present
in both v4.70 and earlier versions.

10. Editing Air Systems I – Under certain conditions, when adding spaces to zones in an air system,
some of the items in the "selected spaces" box were shown as blank lines. This was a display issue
only. The selected spaces were properly saved and used in calculations.

11. Editing Air Systems II - For Rooftop, Vertical Packaged Unit and Split DX AHU VAV systems, if one
of the temperature reset options was chosen for cooling capacity control, the next time the system
was edited, the program changed capacity control to "cycled or staged capacity, fan on". The original
reset control was saved and used in calculations. The problem only occurred if the system was later
edited.

12. Program Startup - When starting the program for the first time, the program would halt and display
an error message "Run time error 372. Failed to load control 'RichTextBox' from 'RICHTX32.OCX".
This error only occurred on certain configurations of Windows 7 and Windows 8 computers. This
error was present in both v4.70 and earlier versions.


